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Hierarchy of Tasks! 
1. Is the PDF document a scanned image? 

a. If yes, perform OCR. 

2. Does the PDF document have form controls (fields)? 

a. This is the only item in the hierarchy that I don’t follow anymore. I start a 

PDF form with a tagged PDF that passes the accessibility full check. 

3. Does the PDF document have links? 

a. If yes, then use the Edit PDF tools to create the links. 

4. Does the PDF document have multimedia? 

a. If yes, then add the multimedia content. 

Make sure that any multimedia content you add includes captions and video description 

and meets any standards or guidelines for the format. 

Only then do you add the Tags to the document! 

Print > Adobe PDF  
If you use the Print > Adobe PDF or any other tool similar to Acrobat, you will create an 

inaccessible untagged PDF. I find it faster by about an hour a page when working with 

forms, to start with a tagged PDF that has passed the Acrobat Accessibility Full Check. 

The Misunderstanding of Tab Order 
It is a misconception that those of us who use adaptive technology “Tab” through content in 

documents. 

We have regular reading and navigation keyboard commands to move through headings, 
paragraphs, lists and other types of text/content on a page. 

We have separate keyboard commands for navigation through tables. 

If tables contain text such as paragraphs or lists, we can encounter 

unreadable/unnavigable content. It is like trying to use a boat (regular keyboard 

commands) on train tracks (table keyboard commands). 

We ONLY Tab through links and form controls! 

We don’t Tab through content! 

If you create the PDF forms to be accessible you can’t forget to Tag the form! 
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Form Design Basics! 
What is the best way to layout a Word document to use as a template for a form> 

Do NOT use Word Form Controls! 
We know that Content Controls are not accessible. 

The form controls do not translate gracefully, if at all, to form controls in PDF documents. 

Most of us in the field are recommending using either HTML based forms or PDF based 

forms, 

If you are going to provide an alternate format of a form in Word, don’t over format it. 

Treat it as if it were a text-based document. 

 

Figure 1 ActiveX form control on left and Content Control on right. 

DON’T use Symbols to Represent Form Controls 
Most people will start clicking on them expecting something to happen. 

Do not use shapes to represent form controls. 

They are not an accessible way to indicate action is required. 

Pretty but non-functioning and not accessible! 

 

Figure 2 Symbols used as visual cues for form controls. 

Create a Clean Form Template 
Instead of trying to match exactly the symbols you place in a Word document, leave the 

space for the form controls in the Word document and then Print > PDF. 

This will save time and give you the flexibility to position form controls. 
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It will also ensure that your Word “form” template is accessible and good to go if needed for 

alternate format. 

Sample Form Template 

 

Figure 3 Sample form used for this series of webinars 

DON’T use Tables for Multi-line Content 
I know we like to help people who may print out a document and handwrite answers, 

however, as we move farther away from the pen and paper model…and as our handwriting 

gets more horrid…we need to think about the effect that providing those helpful guiding 
lines has on those who are filling out the form online. 

If you use a table to provide the guiding lines, the Adobe AutoTag form elements tool will 

see each one as a separate form control. 

It does not have artificial or real intelligence and simply looks for patterns. 

You will need to repair this which takes time…and money. 
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Table used for Layout of Long Answer 

 

Figure 4 Two examples of tables used for layout of long answers. 

Sample of Auto-detect Form Controls 

 

Figure 5 Multiline text form control in Acrobat after using the auto form detect tool. 

Remediation for Multi-line Form Control 
Keep one of the form controls if you use the AutoDetect form controls tool and expand it to 
cover the area indicated by the lines in the template. 

This presents another barrier to accessibility in that as someone types, the text may not be 

“on the line” and cause readability barriers in reviewing answers. 
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Figure 6 One text form control to add comments as a multiline text entry. 

Underline for Short Answers/Signatures 
Some form template authors use the Underline to indicate where to write on a form. 

This assumes the form is going to be printed and handwritten. 

We must start thinking of the purpose and end format of a form. 

Most forms, even if you create one in Word, are going to be filled out online. 

How do we make a form accessible in Word without causing formatting problems and 
barriers to accessibility? 

When you start typing on a “line that has been created using Underline” the “line” begins 
shifting. 

You never really type on the line, you type in front of it, in the middle of it or at the end of it 

and you are left with spacing issues, formatting issues and unprofessional looking forms. 

If you need a guiding line, use the Appearance tab in the Form Properties dialog. 

Sample of Underline in Form Template 

 

Figure 7 Sample of underline used to indicate date and signature placement 
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Do NOT use Underline for Text Marker 

 

Figure 8 Sample of form without Underline used for writing guide 

Digital Signature 
Digital Signatures are nice and do save a lot of time. 

However, to have a certified digital signature, it costs money and many people who will be 

filling in your form will not be able to afford a digital signature subscription. 

Some companies may not be able to afford them either. 

Know your audience – who will primarily be filling in this form? 

Companies who can afford enterprise digital signatures. 

Someone at home or in a company who most likely isn't able to afford a digital signature 

certificate> 

What are the solutions? 

Combination of a required check box signifying that the person understands what they 

have just filled out 

Text field that indicates that by typing your name, this becomes a legal signature. 



Page 10 of 46 
 

Sample Digital Signature Solutions 

 

Figure 9 Sample of alternate structure for signed documents 

Tables as Design Layout for Multiple Options 
Sometimes forms have a series of questions with multiple choices, for example, rate the 
speaker, rate the venue, rate the accessibility. 

Typically, these are radio buttons and can have a range of 1 through 5. 

Tables are often used to arrange answers horizontally across a page. 

If you are doing this, don’t over format the table. 

Keep it simple and clean so that it is easy to understand the visual relationship of the 

questions and responses. 

Use Headings in the Word document (NOT the table) to divide categories of questions. 

Someone using a screen reader or TTS tool is either in reading mode for the document or 

forms mode to fill in the form. 

We can’t be in both modes at the same time! 

We go out of forms mode to read instructions and into forms mode to enter the necessary 
information. 

So, we won’t have access to the table header information while in forms mode.  
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Sample of Table used for Layout 

 

Figure 10 Sample table used to layout rating responses 

Adobe Acrobat Pro DC 
Using the Prepare Form tools – what to do and what not to do. 

Do NOT Accept the “Infer Reading Order” 
I always open the document I want to use as the template for my form before I activate 

Prepare Form tools. 

If you have adaptive technology running or if you’ve turned on warnings, you may get the 

dialog telling you that the document is not tagged and asking if you want to create the 

virtual Tags and infer the reading order from whatever is found. 

Say NO! 

I find that if I let Acrobat create these virtual Tags, it interferes with my ability to create 

real Tags once I’ve added the form controls. 

 

Figure 11 Just say no to inferring the reading order from the document! 
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Choose your Template 
Once you activate the Prepare Form tools, a sort of dialog opens asking if you want to use 
the current document or another document. 

I always open the document I want to use because it saves time and I don’t have to go 

looking for it or the right version of it. 

 

Figure 12 Choose form template dialog. 

Prepare Form Tools 
Recommend that you show the Prepare Form tools in the Tools Task Pane of acrobat Pro 

DC. 

Arrange your Accessibility related tools at the top of the list. 

I’ve used the Dark Display Theme as it is easier to see over longer periods of time. 

Found under View Menu. 

Creating forms is a visual and mouse driven activity. 

 

Figure 13 Prepare Form tools in the Tools Task Pane. 
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Prepare Form Toolbar 

 

Figure 14 Prepare Form Toolbar above document. 

 

Figure 15 Prepare Form tools in the Tools Task Pane. 

Prepare Form Tools Task Pane 
Once you activate the Prepare Form tools, you have other options in the Tools Task Pane to 
the right of the document. 

Show the Tab Order. 

Make sure the Highlight form controls is turned on. 

See the order of the form controls on the page. 

Preview the form: 

Not with adaptive technology! 

Can test the Tab Order. 

Can test the form controls to make sure they are what you want. 
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Show Tab Numbers 

 

Figure 16 Show Tab Numbers setting in the Prepare Form Tools Task Pane. 

 

Figure 17 Notification that you will need to first order the form controls manually. 

Highlight Existing Fields 
In the area between the formatting options for a type of form control and the list of form 

controls on the page are menus for settings such as Tab Order, Tab Numbering and 

Highlight Fields. 

Make sure Highlight Fields is turned on. 

This gives you a better idea of where your form controls are once they lose focus. 

Get a general sense of the form. 

 

Figure 18 Tools settings in the Prepare Form Tools Task Pane. 



Page 15 of 46 
 

Tab Order 
Recommend that you choose to show the Tab Order. 

This will help you keep track of the form controls on the page and in the document. 

The order in which you add form controls is the order in which they will be accessed… 

UNLESS you move them to the correct or logical Tab Order. 

 

Figure 19 Sort order of the form controls setting. 

Importance of ToolTips 
It is critical that all form controls have Tooltips. 

This is what the adaptive technology will use when we enter forms mode to remind us 
about the information being requested/required. 

You also need to Tag the form/document, so we have access to the instructions! 

Don’t write essays in the Tooltips. 

Don’t provide information that is not available to anyone else filling in the form. 

If you think extra information is needed, the form needs to be redesigned! 

Don’t start EVERY Tooltip with Type or Enter…we use first character navigation to quickly 

find the form controls we want. 
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Properties Dialog Showing ToolTip 

 

Figure 20 Object Properties dialog showing ToolTip area. 

Required Fields 
You can make a form control required either when you first add the form control or in the 
Properties dialog. 

To optimize accessibility and comprehension, use the following format in the Tooltip: First 
and last name – required. 

This leaves no doubt that the information is required in order to submit the form. 

 

Figure 21 Required field check box when you first create a form control. 

Navigating and Filling in Forms 
Both JAWS and NVDA have keyboard commands specific to forms. 

Both have what is called a “forms mode” 

When in forms mode, adaptive technology can’t see what surrounds the form control.  The 

focus is on the form control and being in Edit mode. 
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We have a sound that lets us know when we are in and out of Forms mode. 

For example, using JAWS: 

F takes you to the next Form Control, C takes you to the next Combo Box, E takes you to the 

next Edit Field, X takes you to the next Check Box and A takes you to the next Radio Button. 

Shift + F takes you to the previous Form Control and so forth. 

For example, using NVDA: 

F takes you to the next Form Control, R takes you to the next Radio Button and X takes you 

to the next Check Box. 

Text Form Control 
Text form controls are used for name, address, phone number, comments or 

abstract…areas of the form where the user types in information. 

Acronyms 
ToolTips are important for all form controls. 

When using an acronym, for example, American Housing Association, do not type “aha” 
because that is how it will be read. 

Even if you type AHA it will be read as a surprising comment! 

Type A H A or better still, type out American Housing Association. 

Add a Text Form Control 
Text form controls are used for things like name, address, phone number, comments, 
abstract and so forth. 

They can have character limits and be multi-line so that someone can keep typing their 

thoughts. 

 

Figure 22 Adding a text Form Control. 
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Text Form Control Properties 

 

Figure 23 Text form control pop-up. 

Give the form control a meaningful name and then click on All Properties and add a 

ToolTip. 

 

Figure 24 ToolTip area of the Properties dialog. 
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Multi-line Text Form Control 

 

Figure 25 Options tab in text form control Properties dialog. 

In the Options tab of the Text Field Properties dialog, check Multi-line and then decide if 

you want to limit the characters. 

Use Word to Estimate Character Limit 
Word lets you create sandbox text: 

=rand(5, 7) and press Enter where X is the number of sentences and Y is the number of 
sentences per paragraph.  

The default number is 3 sentences per paragraph which you write as =rand(5) and press 

Enter. 

It works in PowerPoint too! 

If you want Latin text, type =lorem(5) and press Enter. 

In Word, you can then press Alt + R, W for Review Ribbon, Word Count. 

You want to use the number of characters WITH spaces. 
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Figure 26 Word Count dialog in Microsoft Word. 

Leave Spell Check Turned on! 

 

Figure 27 Tag Properties dialog showing Options tab with Multiline checked. 

Typically you aren’t going to go into the Appearance tab of the Text Field Properties dialog 

unless you are changing the font size to “Auto” which will automatically adjust the font size 
as someone types into a text form control. 
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Figure 28 Appearance tab in the text form control Properties dialog. 

Set Default Text Form Control Font Size 

 

Figure 29 Set the default settings for all text form controls. 
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Format a Date Form Control 

 

Figure 30 List of possible formats for a form control. 

Found on the Format tab in the Text Field Properties dialog. 

 

Figure 31 Format tab showing Date chosen and correct date format as indicated in the form instructions. 

You WILL get an error message if you type in the date contrary to what is identified by 

using the Format > Date options. 
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Make sure you put the format in the Tooltip for a Date formatted form control. 

 

Figure 32 Incorrect date entry warning message. 

Preview/Edit Mode 

 

Figure 33 Preview button (left) and Edit button (right). 

List Form Controls 
Did you plan for a Combo, Dropdown or List? 

Planning for Lists 
As mentioned last week, you need to plan for which type of list you want to create: 

• Dropdown List. 

• Combo List. 

• List. 

Of these the List takes up the most space as it is represented by a rectangle where ALL 

choices are visible. 

This may not be the most usable list form control. 

Combo Lists let the user enter an option that might not be in the list of possibilities you 

create. 
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Can be a double-edged sword with unexpected answers if question is not clear. 

Dropdown List takes up small amount of space and confines responses to the ones you 

choose. 

Dropdown List 

 

Figure 34 Dropdown List button in the Prepare Form Toolbar. 

Open the All Properties dialog, add a ToolTip and then go to the Options tab. 

 

Figure 35 Dropdown List with initial pop-up Properties dialog. 
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Figure 36 Dropdown List Options in the Properties dialog. 
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Figure 37 Dropdown List option selected showing Up and Down buttons. 

 

Figure 38 Dropdown List expanded in form. 
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“List” Form Control 

 

Figure 39 Add a "square" list to a PDF form. 

 

Figure 40 List form control used instead of a Dropdown List. 

Add a ToolTip and then go to the Options tab. 
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Figure 41 List Options tab showing list of options that can be chosen. 

 

Figure 42 What a List form control looks like completed. 
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Figure 43 The List form control in the form to be filled out. 

Combo List Form Control 
You create a Combo List form control by using the Dropdown List tool on the Prepare Form 

Toolbar in Adobe Acrobat Pro DC. 

The option that makes it a Combo List is that you check a check box to allow users to enter 
custom text. 

You might also want to indicate this in the ToolTip so there is no confusion. 

 

Figure 44 Dropdown and Combo List button on the Prepare Form Toolbar. 

 

Figure 45 Dropdown List and Combo List pop-up. 
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Figure 46 Combo List form control with check box to allow user input checked. 

Switch to Preview mode and test the Combo List. 

Remember that at this point the form is NOT tagged but you can still Tab to the form 
control and type over the default choice which in this case would be Full Time. 

Switch back to Edit mode. 

 

Figure 47 Combo List form control with user entered data. 
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Check Box Form Controls 
When do you use a Check Box and when do you use Radio Buttons? Sometimes it is 
confusing. 

Check Boxes 
I admit that sometimes I get confused as to which one to use. 

Part of the confusion is in reading the question and part of the confusion can come from the 

symbols used in the form template. 

For example, if someone has used a square to indicate a Radio Button instead of a Check 

Box. 

For example, when someone frames the question for a multiple choice answer but has used 
the circle symbol for the “answer area. 

This is not only visually confusing but may result in the incorrect form control being used. 

 

Figure 48 Check Box button on the Prepare Form Toolbar. 

 

Figure 49 First Check Box placed in form with initial dialog. 

The value for each Check Box is going to be the default of “Yes” because when the Check 

Box is checked, it is true/yes. 

The ToolTip would include the answer: I access PDF documents at work; I access PDF 
documents at Home and so forth. 
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Figure 50 Check Box Options showing "Yes" as the export value. 

 

Figure 51 Series of check boxes in a form. 

Pinning Form Controls 
One way to create multiple instances of a form control is to activate the Pushpin on the 

Prepare Form Toolbar. 

This means you don’t have to keep going back to the same form control to add several of 
them at the same time. 

Activate the Pushpin again to choose other form controls. 
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Figure 52 Pin button on Prepare Form Toolbar. 

Duplicating Form Controls 
Another method of crating multiple instances of form controls is to use the context menu 
and choosing to duplicate the form control. 

 

Figure 53 Create multiple form controls horizontally settings. 

You can also duplicate form controls vertically. 
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Figure 54 Create multiple fields showing the correct number of Check Boxes in the settings dialog. 

Resizing Form Controls 
Use the handles of the form control to drag the sides or diagonally  to the size you want. 

In the case of Radio Buttons or Check Boxes, get one the size you want and then select it, 

hold down the Ctrl key and choose the others in the set and then use the context menu to 

size them vertically and horizontally or vertically or horizontally. 

 

Figure 55 First radio button sized smaller as template for size of others in the series. 
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Figure 56 Series of check boxes with first one resized. 

You can also resize form controls from the context menu. 

 

Figure 57 Check boxes selected, and context menus open to resize them. 
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Figure 58 Resized check boxes in the PDF form. 

Radio Buttons 
Use Radio Buttons when you want users to make ONLY one choice among the possible 
answers. 

Add a Group of Radio Buttons 
It is easier to add a Group of Radio Buttons as of Acrobat XI. 

As you add one, you create the Group name and then have the option to add the additional 

Radio Buttons to the set. 

They are represented in the Tools Task Pane as a Group. 

 

Figure 59 Add a group of radio buttons to a form. 

 

Figure 60 Sample question where radio buttons would be used. 
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Figure 61 Radio Button pop-up dialog. 

 

Figure 62 Radio Button pop-up dialog with information filled in. 

 

Figure 63 Radio button being added to a form. 

Continue adding the Radio Buttons until they are all added for a specific group. Then add 
the ToolTip. The Tooltip is shared by all of the Radio Buttons in a group. 



Page 38 of 46 
 

 

Figure 64 Radio Button Properties dialog showing ToolTip. 

 

Figure 65 Radio buttons as they appear in the form. 
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Aligning Form Controls 

 

Figure 66 Series of check boxes selected with alignment options context and sub-menu open. 

 

Figure 67 Radio buttons arranged horizontally in table. 

Remediate Tags 
If you started with an untagged PDF, you Tag the form once you have all of the form 
controls added. Then you go through the Tags Tree and make any necessary remediations. 

If you’ve used lines to indicate where people might print information or sign the form, you 

may have to go into the Content Panel and make all of the lines Artifacts. 

Adding Form Controls in the Tagged Form 
Turn on Tag Annotations in the Tags Panel by activating the Options button and choosing 

Tag Annotations. 
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Figure 68 Tag Annotations in the Options context menu of the Tags Panel. 

Expand the Tag where you want the form control to go. Add a new <Form> Tag. 

Each form control MUST have its own <Form> Tag. 

 

Figure 69 New Tag dialog. 

Select the empty <Form> Tag and then, in the Tags Panel, activate the Options button again 

and choose Find. 
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Figure 70 New <Form> Tag in Tags Tree. 

 

Figure 71 Find in the Options context menu of the Tags Panel. 

When the Find Element dialog opens, choose Unmarked Annotations. 

 

Figure 72 Find Element dialog in Tags Panel. 

When you choose Unmarked Annotations and then activate the Find button, you are moved 

to the first unmarked Annotation in the document. In this case it is our form control. The 

following image shows the form control highlighted and the information in the Find 

Element dialog now showing Find Next or Tag Annotation. 
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Figure 73 Unmarked Annotation found in Find Element dialog. 

Choose Tag Element.  

If you have not created the empty <Form> Tag, a new dialog opens asking you what type of 

Tag the found element is. Choose Form from the Dropdown List. 

 

Figure 74 Tag Type dialog. 

If you have an empty <Form> Tag selected in the tags Tree, the “Form-OBJR will be placed 
in that Tag. 
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Figure 75 Correct semantic for form in a PDF document. 

You will be returned to the Find Element dialog.  

I recommend that you sent up two or three of the empty <Form> Tags and work through 

them, then go on to the next two or three. Unfortunately, you will need to close the Find 

dialog to add each form control. For some reason you can’t just move from the Find dialog 

to the next empty <Form> Tag…Adobe Acrobat won’t let you do that. 

If there are other unmarked Annotations and you will be told the Find is complete if there 

are no more unmarked Annotations. 

 

Figure 76 Find complete for unmarked Annotations 

Accessibility Full Check 
Make sure that the Document Properties (Ctrl + D) has a document title, that in the Initial 

View tab “Document Title” is set to show and that in the Advanced tab, the language is plain 

English, French or Spanish instead of a localized language. 
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Extended Reader Setting 
In order to allow those of us with disabilities to save and fill out a form gradually, you will 
need to turn on the extended Reader settings. 

Only applies to forms, not documents without form controls. 

Allows those of us with disabilities to save the form to our computers and fill it out slowly. 

For example, if we have visual or physical fatigue or have to look something up for the 
form, have limited access to DSL/Broadband. 

File, Save as Other, Reader Extended PDF, Enable More Tools (Including filling in forms and 

save) 

Alt + F, H, D, M. 

Get a dialog with the more options just to confirm what this means. 

Must rename your document. Can use something like “final” or Extended” at the end of the 
filename. 

For example, “ApplicationFormFinal” or “ApplicationFormExtended.” 

 

Figure 77 Save as Reader Extended PDF from File Menu. 
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Figure 78 Message letting you know what features are turned on with Reader Extended choice. 

 

Figure 79 Warning message when you save with extended Reader features. 
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Security Settings 
IF you are going to add security, you MUST allow for the filling out of forms. Must do this 
before applying Reader Extended PDF settings although am not sure you can have both. 

 

Figure 80 Security settings allow for filling in of forms and digital signatures. 

Contact Karen McCall 
Karen McCall, M.Ed., info@karlencommunications.com  

Karlen Communications website1 

There are self-paced online courses for Styles in Word (accessible Word documents) and 

Accessible Fillable PDF Forms as well as copies of my books for purchase on the Karen 

McCall School on Teachable.2 There is also a :course” with free tutorials. The tutorials are 

updated from the website. I find housing them in Teachable lets me e-mail everyone in a 

“course” when new content is added. 

Note: if you live/work in Canada and want to purchase any of the courses 

or books on my Teachable space, I’ll use CAD instead of USD if you are able 

to use an invoice/PO instead of a credit card. 

@KarlenInfo 

                                                        
1 Karlen Communications website: https://www.karlencommunications.com/  
2 Karen McCall School on teachable: https://karen-mccall.teachable.com/  

mailto:info@karlencommunications.com
https://www.karlencommunications.com/
https://karen-mccall.teachable.com/
https://karen-mccall.teachable.com/
https://www.karlencommunications.com/
https://karen-mccall.teachable.com/
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